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Overview 
Relations between extended data types (EDTs) are used in conjunction with relations 
defined on tables in:  

• Join	condition	

• Query/Form	data	source	

• Form	dyna-link	

• Delete	action	

• Lookup	

The order of relations matters when multiple relationships present between two tables: a 
problem by itself 

– EDT relation first or table relation first 

– Order by name or by AOT order 

EDT relations are also used stand alone for unbound control lookup 
 
The issues with EDT Relations are: 

• There are approximately 14000 total relations to be added to tables for complete 
system layer migration 

• CustTableCube with the largest number of relations (68) 

• 176 EDT relations need to be investigated 

• Possible change of behavior when multiple relationships present between two tables 

– Relation used for joins 

• Query: can be corrected by explicit join/relation 

• Form join/dyna-link  

– Relation used for  delete action. 

Migration Process 

Migration Steps: 

1. Fix uniqueness issue if applicable 

2. Copy the relation from the extended data type to all hosting tables. 

a. Foreign key relation if possible. 

b. Normal relation/fixed relation. 

3. Add relational properties. 

4. Move the EDT relation to a table reference node. 



 
 

4 
 
MIGRATING EXTENDED DATA TYPE RELATIONS IN MICROSOFT DYNAMICS AX 2012 

5. Test 

a. Test after the relation has been marked as “migrated”. 

b. Limited test if no multiple relations with other tables present 

i. How to identify 

c. Targeted test otherwise 

i. Determine what to test. 

ii. Explicitly set relationship if needed. 

6. Check-in 

EDT Relation Migration Tool 

The EDT relation migration tool is used to automate the migration process. 
 
This tool can be used to perform the following actions: 
 

• Copy an EDT relation to all hosting tables. 

• Automatically populate relation properties. 

o Derive cardinality from the index on the foreign key. 

o Derive the relationship type from the delete action/key composition. 

o Assign role names. 

• Copy an EDT relation a to table reference node. 

• Report artifacts impacted with before/after behavior change depending on which 
relation is used. 

o Query 

o Forms 

o Delete actions on tables 

• Explicitly set the relationship to maintain existing behavior. 

Using the EDT Relation Migration Tool 
Open the form for the migration tool by navigating to it from Tools > Code upgrade > 
EDT relation migration tool.  

Denise Juppe� 12/15/2010 2:05 PM
Deleted: R
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The first time you open the tool, it will ask if you want to refresh the EDT relations data. 
Select Yes to perform this action, which takes about 5-10 minutes to complete.  
 
The UI of the tool is as follows: 

 

Key to terms on the form: 

The Table name pane on the left side of the screen displays all of the table names in the 
Application Object Tree (AOT). 
The EDT relations table displays all of the EDT relations for the table selected in the left 
pane.  
This table contains the following columns: 
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Extended data type name: Name of the extended data type on which the field is based. 
Field name: Name of the field which is based on an EDT. 
Related table name: Name of the table to which the EDT relation on the field points. 
Related field name:  Name of the table to which the EDT relation on the field points. 
Has relation constraints: Indicates whether the EDT specified in the Extended data 
type name column has any ‘FieldFixed’ relations. When an EDT relation is migrated, the 
newly created relation should also have ‘FieldFixed’ relations. 
Index type: indicates whether the EDT field on the primary table is part of any primary key 
(PK), Unique, alternate key (AK), or composite index. 
Multi relations: Determines this EDT relation is one of two or more EDT relations between 
the table holding the field and the related table.  
Migration status = Indicates the migration state. This is a read-only column and can have 
one of four states: 

• Migrated 
• NotMigrated 
• MigratedToIgnoreEDTRelation 
• MigratedToExistingTableRelation 

Refer to a case study here that explains a data model in which the EDTRelation on the field 
is appropriate to ignore. 
Migration action:  A drop-down menu provides a set of available actions from which to 
choose. The actions are “Skip”, “Migrate”, “Mark as ignore EDT relation”. 

• Skip:  To skip the migration. 
• Migrate:  To migrate the relation to the table relation. 
• Mark as ignore EDT relation:  To set the value of the new IgnoreEDTRelation 

property on the EDT field to Yes. The default value for this property is No. 

To migrate EDT relations on a single table 

• Select a table from the Table name pane on the left of the screen. 
• Select a relation in the EDT relations table and choose an action from the 

Migration action drop-down menu.  
• After you have set an action on all the relations for that table, click the Migrate 

single table button. 
 

Note  The migration tool tries to find a match for the EDT relation in the existing table 
relations. If the relation is found, the matching relation lines in the relation are marked 
(SourceEDT property on the relation is set to the EDT name). 

If no match is found on the existing table relations, the tool will create a new relation only if 
the  Index on the Primary table (shown by -‘IndexType’) is “PK or AK”. If the matching 
Index for EDT field on Primary is NoIndex/Unique/NonUnique, the tool will not create a new 
relation. 
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To migrate EDT relations on multiple tables 

	
In	the	left	Grid,	select	all	the	tables	on	which	you	want	to	migrate	the	relation		and	click	the	“Migrate	

multiple	tables”	button.	
	

Note			In	multi	select	mode,	you	cannot	pick	a	migration	action	per	table	relation.	It	is	“Migrate”	by	

default	and	need	not	be	set	for	each	relation	on	each	table.	A	dialog	shows	up	saying	that	default	action	
is	“Migrate”	and	will	migrate	EDT	relations	on	all	the	selected	tables.	If	“Yes”	is	chosen	on	this	Dialog	
box,	then	the	relations	are	migrated,	if	“No”	is	chosen	nothing	will	happen.	
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Migration Scenarios 
This document explains what happens when EDT relation migration happens in different 
scenarios. The scenario number is as follows (the list is not complete yet). 
 
Scenario EDT normal 

relation 
points to 
Unique Key? 

EDT fixed 
relation 
points to 
unique 
key 

Existing 
table 
relation 
exactly 
matching 
EDT 
relation? 

Existing 
table 
relation a 
super set of 
EDT 
relation? 

Existing 
table 
relation a 
subset of 
EDT 
relation? 

1 Yes No No No No 

2 Yes No Yes No No 

3 Yes No No Yes No 

4 No. EDT 
relation does 
not have 
fixed field 
links but 
referenced 
field is not a 
unique key by 
itself. 

No No No No 

5 No. EDT 
relation has 
fixed field 
links. 

Yes No No No 

6 Yes. EDT 
relation has 
fixed field 
links 

EDT fixed 
relation 
points to a 
super set 
of a 
unique 
key 

No No No 
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In the example, we will use PKTable and FKTable with PKTable holding the referenced key 
and FKTable holding referencing key pointing to PKTable. 
This document does not cover filling in the table relation property part, which is discussed in 
a separate document 
(http://dynamics/functionalteams/Architecture/AX6/planvteam/relational101/Shared%20Do
cuments/Dynamics%20AX%20AOT%20Table%20Relation%20Properties%20Guideline.docx
). 
The section under runtime behavior is for understanding how the markers are used by 
kernel to maintain backward compatibility and not something app developer should concern 
themselves with, as long as the markers are set correctly.  

Scenario 1 

 
In the example below, the EDT PKTableField1 defines a relation to ‘PKTable.Field1’ which by 
itself is an alternate key AK1. So this is a conforming relation. 
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‘FKTable.Field1’ uses EDT PKTableField1 which makes it a FK into PKTable but there is no 
table relation defined on the table.  
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When you open the EDTMigration tool, this is what shows 
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In the ‘Pick a Migration Action’ column, pick Migrate and click the ‘Migrate Table Relations’ 
button on the upper right corner. 
The migration will  
 

(1) Create	a	new	relation	PKTable	of	type	‘Normal’	(as	the	Key	is	not	PK).	

(2) The	EDTRelation	property	it	set	to	‘true’	as	this	relation	is	added	due	to	EDT	relation	migration.	
(3) The	relation	will	have	one	field	link.	
(4) The	field	link	will	have	SourceEDT	set	to	EDT	PKTableField1.	

 
Runtime behavior 

(1) APIs	that	uses	EDT	relation	first	on	‘FKTable.Field1’	now	will	be	able	to	find	the	same	relation	
with	the	same	field	link	under		PKTable	relation	by	examining	the	SourceEDT	flag.	

(2) APIs	that	uses	table	relation	first	will	not	pick	up	the	PKTable	relation	first	as	it	is	flagged	as	
EDTRelation.		
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Scenario 2 
 
This scenario is similar to scenario 1. The ‘FKTable.Field2’ holds the extended data type 
PKTableField1 as a foreign key into PKTable. However, there is already an existing table 
relation PKTable2 defined on the table with exactly the same field link. 



 
 

16 
 
MIGRATING EXTENDED DATA TYPE RELATIONS IN MICROSOFT DYNAMICS AX 2012 

 
 
The migration will  

(1) Not	create	a	new	relation	as	there	is	already	an	existing	table	relation	that	matches	the	EDT	
relation.	

(2) The	EDTRelation	property	remains	‘No’	as	this	relation	is	not	added	due	to	EDT	relation	
migration.	

(3) The	field	link	will	have	SourceEDT	set	to	EDT	PKTableField1	to	indicate	that	this	matches	the	EDT	

relation	defined	on	EDT	PKTableField1.	

Runtime behavior 

(1) APIs	that	uses	EDT	relation	first	on	‘FKTable.Field2’	now	will	be	able	to	find	the	same	relation	
with	the	same	field	link	under	PKTable2	relation	by	examining	the	SourceEDT	flag.	

(2) APIs	that	uses	table	relation	first	will	still	pick	up	the	PKTable2	relation	first	as	it	is	not	flagged	as	
EDTRelation.		
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Scenario 3 
 
Scenario 3 is similar to scenario 2, the ‘FKTable.Field3’  uses EDT PKTableField1 which 
makes it a FK into PKTable but there is an existing table relation PKTable3 defined already 
on the table but the relation has more field links defined on it than the EDT relation. 
In the example shown below, Field4 in FKTable is duplicated (denormalized) from PKTable 
Field2. But it could also be a related fixed field link. 
 

 
 
 
The migration will  

(1) Not	create	a	new	relation	as	there	is	already	an	existing	table	relation	that	covers	the	EDT	
relation	field	link.	

(2) The	EDTRelation	property	remains	‘No’	as	this	relation	is	not	added	due	to	EDT	relation	
migration.	
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(3) The	field	link	that	matches	EDT	relation	will	have	SourceEDT	set	to	EDT	PKTableField1	to	indicate	
that	this	matches	the	EDT	relation	defined	on	EDT	PKTableField1.	

(4) The	field	link	that	does	not	match	EDT	relation	will	have	SourceEDT	set	o	empty	as	it	does	not	
match	the	EDT	relation	field	link.	

 
Runtime behavior 

(1) APIs	that	uses	EDT	relation	first	on	‘FKTable.Field2’	now	will	be	able	to	find	the	same	relation	

with	the	same	field	link	under	PKTable2	relation	by	examining	the	SourceEDT	flag	and	taking	
only	field	links	that	have	a	matching	SourceEDT.	

(2) If	this	field	link	is	deleted,	it	will	then	look	up	relation	under	EDT.		
a. If	EDT	relation	is	removed,	then	the	lookup	field	is	used	if	the	lookup	is	a	result	of	EDT	

migration	(we	need	a	flag	there	as	well?).	
(3) APIs	that	uses	table	relation	first	will	still	pick	up	the	PKTable2	relation	first	as	it	is	not	flagged	as	

EDTRelation.		

 

Scenario 4 
 
There are two cases for this: 
Case Is the referenced field part 

of an alternate key? 
 

1 Yes  
2 No  
 

Case 1 

 
In the example below, EDT PKTableField2 defines a relation to ‘PKTable.Field2’ which by 
itself is not a unique key but belongs to AK2 which includes Field2 and Field3.  
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FKTable.Field5 uses PKTableField2 but there is no existing relation on FKTable that contains 
Field5. 
 
The developer can do one of the two things 
 

(1) If	there	is	a	relationship	from	FKTable	to	PKTable	
a. If	the	corresponding	foreign	key	on	FKTable	that	points	to	PKTable.Field3	already	exists,	

create	a	relation	with	that	field	together	with	FKTable.Field5.	
b. If	not,	this	indicates	the	data	model	is	wrong.		Create	an	additional	field	on	FKTable	and	

create	a	relation	with	that	field	together	with	FKTable.Field5.	You	may	need	upgrade	

script	to	populate	the	added	fields.	
(2) If	there	is	no	relationship,		ignore	the	EDT	relation.	

Case 2 

 
For 1.2, the migration will  

(1) Create	a	new	relation	which	includes	two	field	links	as	mentioned	above.	
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(2) The	EDTRelation	property	set	to	‘Yes’	as	this	relation	is	added	due	to	EDT	relation	migration.	
(3) The	field	link	that	matches	EDT	relation	will	have	SourceEDT	set	to	EDT	PKTableField2	to	indicate	

that	this	matches	the	EDT	relation	defined	on	EDT	PKTableField2.	
(4) The	field	link	that	does	not	match	EDT	relation	will	have	SourceEDT	set	o	empty	as	it	does	not	

match	the	EDT	relation	field	link.	

Runtime behavior 
(1) APIs	that	uses	EDT	relation	first	on	‘FKTable.Field5’	now	will	be	able	to	find	the	same	relation	

with	the	same	field	link	under	PKTable5	relation	by	examining	the	SourceEDT	flag.	

(2) APIs	that	uses	table	relation	first	will	no	pick	up	the	PKTable2	relation	first	as	it	is	flagged	as	
EDTRelation.		

 
The following shows the result of 1.a. 
 

 
 
 
For scenario 2, in the action option for this EDT relation, pick ‘Mark Ignore EDT Relation’ 
(currently labeled ‘Marked as migrated’).  
The change below is still going through review and not implemented yet. 
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The migration will  
(1) Will	not	create	a	new	relation		
(2) FKTable.Field5	‘IgnoreEDTRelation’	is	set	to	TRUE.	

Runtime behavior 
(1) APIs	that	uses	EDT	relation	first	on	‘FKTable.Field5’	now	will	have	to	be	divided	into	two	groups	

a. Those	that	require	relational	semantics,	like	joins,	delete	action	etc	will	not	use	the	EDT	
relation	as	it	is	marked	as	IgnoreEDTRelation.	

b. Those	that	does	not,	like	lookup,	will	still	see	EDT	relation.	

 

Case 5 and 6 
 
EDT relation has fixed field links in both these two scenarios.   
In scenario 5, the entire set of referenced field makes up a unique key. However, only one 
of the referencing fields is present in the referencing table. Syntactically, this is not a 
relationally correct FK relationship because the complete set of FK is not available. But 
because the rest of the FK values will all be constant (and thus redundant) they are simply 
omitted from the table and expressed in the fixed field relation. 
In scenario 6, the fixed field links serve as a filter condition on top of the relation expressed 
by the normal field link. 
The migration tool can handle both scenarios and create new normal table relations, with 
‘EDT Relation’ property set to TRUE on the new relation and ‘SourceEDT’ set to the EDT on 
all of the field links, including the fixed field links. 
 

 

The following is a sample table. To use this format throughout the document, copy and paste 
the table, and add, resize, and delete rows and columns as needed. For text in the table, use 
the defined Table Heading and Table Text paragraph formats. A 1½-pt. vertical white line separates 
columns. Add a blank Spacing paragraph after each table, as is done in the example below. 
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Table Heading Table Heading 

Table Text Table Text 

Table Text Table Text 

Table Text Table Text 

• Table Text Bullet 

• Table Text Bullet 
 

Note:  The Table Heading, Table Text, and Table Text Bullet formats have built-in left and right 
indents. The table cell properties specify no additional indent. Align tables flush with the left 
margin of the text immediately above it. Do not center tables, and make sure tables don’t overlap 
the right text margin. To show the text margins, choose Tools > Options. On the View tab, 
mark the Text Boundaries box. 
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Formatting code and scripts [Heading 1] 
The following is a sample of code. Format all code or scripts with the “Code” paragraph format, which 
uses the monospaced Courier New font. There is no indented version of this style, because it contains 
indents every .25 inch. Just use tabs to add indents if the code appears below an indented text block. 
To set the code off from text above and below it, just use blank paragraph returns. 

 

static void Job1(Args _args) 

{ 

 MySampleClass.Class1 MySample; 

 str MySampleReturn; 

 ; 

 MySample = new MySampleClass.Class1(); 

 MySampleReturn = MySample.ReturnDataToAX(); 

 

 info(MySampleReturn); 

} 
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